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TIIVISTELMÄ
: 

Tampereen yliopisto

 

Tiivistelmä on suppea, 1 sivun mittainen itsenäinen esitys työstä: mikä oli ongelma, mitä tehtiin ja mitä saatiin tulokseksi. Kuvia, kaavioita ja taulukoita ei käytetä tiivistelmässä.
Laita työn pääkielellä kirjoitettu tiivistelmä ensin ja käännös sen jälkeen. Suomenkieliselle kandidaatintyölle pitää olla myös englanninkielinen nimi arkistointia varten.
Tässä pohjassa tiivistelmää varten 2 omaa tekstityyppiä: tunnistetiedoille tyyli CoverBodyText2 ja tiivistelmätekstille Abstract, jossa riviväli on 1.0. Otsikkotyyppi on Heading (no number), joka tekee automaattisesti sivunvaihdon (Page break before). Samaa otsikkotyyppiä käytetään mm. sisällysluettelossa. Lähdeluettelossa on identtinen tyyppi hieman eri nimellä, jolloin se voidaan poimia sisällysluetteloon. Sivunumeroja varten etusivun lopussa pitää olla Section Break ja tiivistelmän yläotsakkeen (header) asetus Link to Previous pois päältä, ja lisäksi sivunumeron muotoilusta Start at i (eikä Continue).


Avainsanat: Tiivistelmä-tekstin jälkeen.


Tämän julkaisun alkuperäisyys on tarkastettu Turnitin Originality Check -ohjelmalla.

abstract
: 

Tampere University

 

The abstract is a concise 1-page description of the work: what was the problem, what was done, and what are the results. Do not include charts or tables in the abstract.
Put the abstract in the primary language of your thesis first and then the translation (when that is needed).
This document template has two text styles for abstract. BibInfo is for bibliographical information above whereas the rest uses the style Abstract, which has line spacing of 1.0. The style Heading (no number) is used in the frontmatter before actual text and it makes the necessary preceding page break. Similar style is used in the bibliography with slightly different name in order to include it in the table of contents. The title page must end with Section Break to get pages numbered correctly. Moreover, the header on this page turns off the setting Link to Previous and formats the page numbers to Start at 1 (instead of Continue).

Keywords: After Abstract-text


The originality of this thesis has been checked using the Turnitin Originality Check service.
ALKUSANAT
Tämä dokumenttipohja on laadittu Tampereen yliopiston tekniikan alan opinnäytetöitä varten. Mallipohja perustuu aikaisemmalla Tampereen teknillisen yliopiston pohjalle, mutta se on päivitetty vuonna 2019 toimintansa aloittavaa Tampereen yliopistoa varten. 
Alkusanoissa esitetään opinnäytetyön tekemiseen liittyvät yleiset tiedot. Tapana on myös esittää kiitokset työn tekemiseen vaikuttaneille henkilöille ja yhteisöille. Alkusanat eivät kuulu arvioinnin piriin, mutta niissä ei silti ole sopivaa moittia tai kritisoida ketään. Alkusanojen pituus on enintään 1 sivu. Alkusanojen lopussa on päivämäärä, jonka jälkeen työhön ei ole enää tehty korjauksia.

Tampereella, 15.2.2019

Päivittäjä
SISÄLLYSLUETTELO
1.	Johdanto	1
1.1	Teksti	2
1.2	Kuvat	3
1.3	Taulukot	4
1.4	Matemaattiset merkinnät	5
1.5	Ohjelmat ja algoritmit	7
2.	Viittaustekniikat	8
2.1	Lähdeviittaukset tekstissä	8
2.2	Lähdeluettelo	9
3.	Yhteenveto	10
Lähteet	11
Liite A: MS Wordin tekstityylien käyttö	12


KUVALUETTELO
Kuva 1.	Kuvaaja on hyvä muokata julkaisukelpoiseksi. Vasemmalla on esitetty muokkaamaton kuvaaja ja oikealla muokattu.	3
Kuva 2.	Tyylit kirjoitusohjeen versioissa 11.3 ja 11.5	11

Tämä luettelo on vapaaehtoinen. Kuvaluettelo lisätään References > insert Table of Figures ja sieltä Options… > Build table of figures based on > Style:Figure Caption. Myös taulukkoluettelon saa samasta kohdasta, kun valitsee viimeisestä kohdasta tyylin Table Caption. 

LYHENTEET JA MERKINNÄT
CC-lisenssi 		Creative Commons -lisenssi
LaTeX		ladontajärjestelmä tieteelliseen kirjoittamiseen
SI-järjestelmä 	ransk. Système international d’unités, kansainvälinen mittayksikköjärjestelmä 
TTY		Tampereen teknillinen yliopisto
URL		engl. Uniform Resource Locator, verkkosivun osoite

a		kiihtyvyys
F	voima
m	massa
Työssä käytetyt lyhenteet ja merkinnät määritellään ja selitetään kootusti aakkosjärjestyksessä työn alussa ja kun ne esiintyvät tekstissä ensimmäisen kerran Lyhenteiden kanssa käytetään tällöin sulkeita. Selitetekstin tyyli on tässä Symbol description. Tämän sivun lopussa on Section Break, jotta sivunumerointi menee oikein. Lisäksi johdannon yläotsakkeen (header) asetus Link to Previous on pois päältä, ja lisäksi sivunumeron muotoilusta on valittu Start at 1 (eikä Continue).
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[bookmark: _Toc535531167]Johdanto
Tämä mallipohja liittyy Tampereen yliopiston tekniikan alan opinnäytteiden kirjoitusohjeisiin [1]. Opinnäyte tai raportti koostuu tyypillisesti seuraavista osista:
Nimiölehti
Tiivistelmä
Abstract (englanninkielinen tiivistelmä)
Alkusanat
Sisällys
Lyhenteet ja merkinnät
1. Johdanto
2. Teoreettinen tausta, lähtökohdat tai ongelman asettelu 
3. Tutkimusmenetelmät ja aineisto 
4. Tulokset ja niiden tarkastelu (mahdollisesti eri luvuissa)
[bookmark: _Ref117930627]5. Yhteenveto tai päätelmät
Lähteet
Liitteet (eivät pakollisia)

Jokainen yllämainituista osista aloitetaan uudelta sivulta. Osioiden 1–5 nimet ovat tässä ainoastaan esimerkkejä. Käytä työssäsi paremmin sisältöä kuvaavia nimityksiä. Nimiölehdelle tulee yliopiston logo, tekijä, työn nimi ja opinnäytetyön taso (lisensiaatintyö, diplomityö, kandidaatintyö, harjoitustyö). Lisäksi merkitään työn tarkastukseen jättämisen ajankohdan kuukausi ja vuosi. Sisällysluetteloon kootaan kaikki sitä seuraavat otsikot, erityisesti numeroidut. Aina siihen ei laiteta osia ennen sisällysluetteloa. MS Wordin automaattinen toiminto löytyy References > Table of Contents.
Johdannossa herätetään lukijan mielenkiinto, perehdytetään hänet tutkimuksen aihepiiriin ja jäsennetään tutkimus. Seuraavaksi esitellään opinnäytetyön taustatiedot, jotka ovat välttämättömiä työn ongelman ymmärtämiselle. Toisinaan tässä kuvataan myös käytetyt menetelmät ja –aineisto eli miten tutkimus on toteutettu. 
Sen jälkeen esitellään työssä saavutetut tulokset, niiden merkitys, virhelähteet, poikkeamat oletetuista tuloksista ja tulosten luotettavuus. Yhteenveto on työn tärkein osio. Siinä ei enää toisteta yksityiskohtaisen tarkkoja tuloksia, vaan päätulokset kootaan yhteen ja pohditaan niiden merkitystä. Lähdeluettelon antaa kuvan työn teoreettisesta ja empiirisestä pohjasta sekä toimii kirjallisuusluettelona. Siinä esitetään kaikki tarvittavat tiedot kunkin julkaisun löytämiseksi.
Tämän pohjan luvussa 2 käsitellään esityyliin perussäännöt liittyen kuviin, taulukoihin ja matemaattisiin merkintöihin. Luvuissa 3 ja 4 esitellään viittaustekniikat ja lyhyt yhteenveto. Liitteenä on huomioita MS Wordin tekstityyleistä.
Esitystyyli
Tekstin sisällön lisäksi esitystyyli vaikuttaa suuresti viestinnän onnistumiseen. Ulkoasu ja kirjoitustyyli antavat työstä ja kirjoittajasta kuvan, toivottavasti hyvän.
[bookmark: _Toc535531168]Teksti
Opinnäytetyö kirjoitetaan yhdelle palstalle. Opinnäytetyön tavallisen tekstin kirjasinlaji on Arial 11 pistettä. Riviväli on 1,5, ja teksti tasataan ja tavutetaan. Luvun otsikon kirjasin on 18 pisteen Arial, ja molemmin puolin on 42 pisteen väli ennen tekstiä. Alaluvun otsikon kirjasinkoko on 14, ja otsikon yläpuolella on 18 pisteen väli ja alapuolella 12 pisteen väli. 
Kirjoitustyylin perusohjeet ovat:
Ajattele lukijaa aina tekstiä kirjoittaessasi ja johdattele häntä riittävästi. Anna ensin yleiskuva ja liitä siihen yksityiskohdat. 
Korosta tärkeimmät asiat, esimerkiksi nostamalla ne omiksi luvuikseen, poimimalla taulukkoon tai selittämällä kuvan avulla. Tekstissä käytä korostamiseen kursivointia tai lihavointia, mutta älä korosta liikaa.
Vältä pitkiä virkkeitä ja monimutkaisia lauserakenteita. Piste on paras välimerkki. 
Suosi aktiivimuodossa olevia verbejä ja sijoita ne lauseen alkupuolelle. Älä kuitenkaan käytä yksikön 1. persoonaa (minä) kuin Alkusanoissa. 
Vältä kapulakielisiä ilmauksia ja ammattislangia. Sano suoraan. Käytä vakiintunutta teknistä sanastoa, merkintöjä ja neutraalia asiatyyliä. 
Lukujen ja alalukujen tulee olla vähintään kahden kappaleen mittaisia ja mielellään keskenään tasapainoisia. Kappale muodostuu aina useammasta kuin yhdestä virkkeestä. 
Luvut ja alaluvut numeroidaan korkeintaan kolmannelle tasolle asti, esimerkiksi 4.4.2.
Lyhenteitä ei tulisi käyttää liikaa. Käytä lyhenteissä pieniä ja isoja kirjaimia johdonmukaisesti. 
Tekstin tyyli on Body text ja sen kieli on tässä Finnish. Otsikoiden tyylit ovat Otsikko 1, 2 ja 3. Lisäksi alkuosan numeroimattomille otsikoille ja lähdeluettelolle on tyyli Heading (no number). Listoja varten ovat List (numbered), List (bullets) ja List (no bullets or numbers). Jos ja kun tekstisi menee hieman rikki, vaikkapa sisennyksen tai fontin osalta, helpoin tapa korjata maalata teksti, valita tyylivalikosta Clear All ja sen jälkeen haluttu tyyli. Lisä[image: ][image: kuva1]huomioita tyyleistä on liitteenä.
Kuvaaja on hyvä muokata julkaisukelpoiseksi. Vasemmalla on esitetty muokkaamaton kuvaaja ja oikealla muokattu.
[bookmark: _Toc363738141][bookmark: _Toc535531169]Kuvat
[bookmark: _Toc118865069][bookmark: _Toc119224916]Kaikkiin kuviin täytyy viitata tekstissä. Kuvan avulla voidaan esittää tietoa tiiviissä muodossa, mutta kuvan täytyy olla merkityksellinen työn sisällön kannalta ja kuva täytyy selittää tekstissä. Viittaus on mielellään samalla sivulla kuin kuva tai sitä ennen. Kuvat ja taulukot numeroidaan ja sijoitetaan pääsääntöisesti sivun yläreunaan, oman harkinnan mukaan. Lukua ei saa aloittaa kuvalla, taulukolla tai luettelolla, vaan sitä ennen on oltava tekstiä. Kuvateksti sijoitetaan kuvan alle ja aina ehdottomasti samalle sivulle kuin kuva.
[bookmark: _Toc381026012][bookmark: _Toc381026470][bookmark: _Toc381539801][bookmark: _Toc381541019][bookmark: _Toc381541091][bookmark: _Toc381541164][bookmark: _Toc381541238][bookmark: _Toc381541313][bookmark: _Toc381026013][bookmark: _Toc381026471][bookmark: _Toc381539802][bookmark: _Toc381541020][bookmark: _Toc381541092][bookmark: _Toc381541165][bookmark: _Toc381541239][bookmark: _Toc381541314][bookmark: _Toc381026014][bookmark: _Toc381026472][bookmark: _Toc381539803][bookmark: _Toc381541021][bookmark: _Toc381541093][bookmark: _Toc381541166][bookmark: _Toc381541240][bookmark: _Toc381541315][bookmark: _Toc381026015][bookmark: _Toc381026473][bookmark: _Toc381539804][bookmark: _Toc381541022][bookmark: _Toc381541094][bookmark: _Toc381541167][bookmark: _Toc381541241][bookmark: _Toc381541316][bookmark: _Toc381026016][bookmark: _Toc381026474][bookmark: _Toc381539805][bookmark: _Toc381541023][bookmark: _Toc381541095][bookmark: _Toc381541168][bookmark: _Toc381541242][bookmark: _Toc381541317][bookmark: _Toc381026017][bookmark: _Toc381026475][bookmark: _Toc381539806][bookmark: _Toc381541024][bookmark: _Toc381541096][bookmark: _Toc381541169][bookmark: _Toc381541243][bookmark: _Toc381541318][bookmark: _Toc374306218][bookmark: _Toc374306427][bookmark: _Toc380150143][bookmark: _Toc380150291][bookmark: _Toc380157813][bookmark: _Toc380157873][bookmark: _Toc381026021][bookmark: _Toc381026479][bookmark: _Toc381539810][bookmark: _Toc381541028][bookmark: _Toc381541100][bookmark: _Toc381541173][bookmark: _Toc381541247][bookmark: _Toc381541322][bookmark: _Toc374306219][bookmark: _Toc374306428][bookmark: _Toc380150144][bookmark: _Toc380150292][bookmark: _Toc380157814][bookmark: _Toc380157874][bookmark: _Toc381026022][bookmark: _Toc381026480][bookmark: _Toc381539811][bookmark: _Toc381541029][bookmark: _Toc381541101][bookmark: _Toc381541174][bookmark: _Toc381541248][bookmark: _Toc381541323][bookmark: _Toc374306220][bookmark: _Toc374306429][bookmark: _Toc380150145][bookmark: _Toc380150293][bookmark: _Toc380157815][bookmark: _Toc380157875][bookmark: _Toc381026023][bookmark: _Toc381026481][bookmark: _Toc381539812][bookmark: _Toc381541030][bookmark: _Toc381541102][bookmark: _Toc381541175][bookmark: _Toc381541249][bookmark: _Toc381541324][bookmark: _Toc374306221][bookmark: _Toc374306430][bookmark: _Toc380150146][bookmark: _Toc380150294][bookmark: _Toc380157816][bookmark: _Toc380157876][bookmark: _Toc381026024][bookmark: _Toc381026482][bookmark: _Toc381539813][bookmark: _Toc381541031][bookmark: _Toc381541103][bookmark: _Toc381541176][bookmark: _Toc381541250][bookmark: _Toc381541325][bookmark: _Toc374306222][bookmark: _Toc374306431][bookmark: _Toc380150147][bookmark: _Toc380150295][bookmark: _Toc380157817][bookmark: _Toc380157877][bookmark: _Toc381026025][bookmark: _Toc381026483][bookmark: _Toc381539814][bookmark: _Toc381541032][bookmark: _Toc381541104][bookmark: _Toc381541177][bookmark: _Toc381541251][bookmark: _Toc381541326][bookmark: _Toc374306223][bookmark: _Toc374306432][bookmark: _Toc380150148][bookmark: _Toc380150296][bookmark: _Toc380157818][bookmark: _Toc380157878][bookmark: _Toc381026026][bookmark: _Toc381026484][bookmark: _Toc381539815][bookmark: _Toc381541033][bookmark: _Toc381541105][bookmark: _Toc381541178][bookmark: _Toc381541252][bookmark: _Toc381541327][bookmark: _Toc374306224][bookmark: _Toc374306433][bookmark: _Toc380150149][bookmark: _Toc380150297][bookmark: _Toc380157819][bookmark: _Toc380157879][bookmark: _Toc381026027][bookmark: _Toc381026485][bookmark: _Toc381539816][bookmark: _Toc381541034][bookmark: _Toc381541106][bookmark: _Toc381541179][bookmark: _Toc381541253][bookmark: _Toc381541328][bookmark: _Toc374306225][bookmark: _Toc374306434][bookmark: _Toc380150150][bookmark: _Toc380150298][bookmark: _Toc380157820][bookmark: _Toc380157880][bookmark: _Toc381026028][bookmark: _Toc381026486][bookmark: _Toc381539817][bookmark: _Toc381541035][bookmark: _Toc381541107][bookmark: _Toc381541180][bookmark: _Toc381541254][bookmark: _Toc381541329][bookmark: _Toc374306226][bookmark: _Toc374306435][bookmark: _Toc380150151][bookmark: _Toc380150299][bookmark: _Toc380157821][bookmark: _Toc380157881][bookmark: _Toc381026029][bookmark: _Toc381026487][bookmark: _Toc381539818][bookmark: _Toc381541036][bookmark: _Toc381541108][bookmark: _Toc381541181][bookmark: _Toc381541255][bookmark: _Toc381541330][bookmark: _Toc374306227][bookmark: _Toc374306436][bookmark: _Toc380150152][bookmark: _Toc380150300][bookmark: _Toc380157822][bookmark: _Toc380157882][bookmark: _Toc381026030][bookmark: _Toc381026488][bookmark: _Toc381539819][bookmark: _Toc381541037][bookmark: _Toc381541109][bookmark: _Toc381541182][bookmark: _Toc381541256][bookmark: _Toc381541331][bookmark: _Toc374306228][bookmark: _Toc374306437][bookmark: _Toc380150153][bookmark: _Toc380150301][bookmark: _Toc380157823][bookmark: _Toc380157883][bookmark: _Toc381026031][bookmark: _Toc381026489][bookmark: _Toc381539820][bookmark: _Toc381541038][bookmark: _Toc381541110][bookmark: _Toc381541183][bookmark: _Toc381541257][bookmark: _Toc381541332][bookmark: _Toc374306229][bookmark: _Toc374306438][bookmark: _Toc380150154][bookmark: _Toc380150302][bookmark: _Toc380157824][bookmark: _Toc380157884][bookmark: _Toc381026032][bookmark: _Toc381026490][bookmark: _Toc381539821][bookmark: _Toc381541039][bookmark: _Toc381541111][bookmark: _Toc381541184][bookmark: _Toc381541258][bookmark: _Toc381541333]Kuvan keskeinen sisältö on selitettävä tekstissä, jotta sen sanomasta ei jää epäselvyyttä. Analysointiohjelmistojen tuottamat kuvat vaativat useimmiten muokkausta, kuten Kuva 1. Kuvan tekstien on oltava luettavissa, ja niiden kooksi suositellaan samaa kuin muussa tekstissä. Pyri siihen, että myös harmaasävyissä tulostettu kopio on luettava ja selkeä. 
Kuvia voi MS Wordissa lisätä esimerkiksi Insert > Picture tai suoraan toisesta ohjelmasta copy-pastella. Jälkimmäisessä kannattaa valita Paste special > Picture (Enhanced metafile), sillä kuvien tuominen MS office graphic objectina usein vaikeuttaa asioita. Kuva 1 on itse asiassa 2-rivinen reunaviivaton taulukko, jotta pikkukuvat saadaan hallitusti rinnakkain. Kuvia joutuu aina päivittämään. Valitse silloin ensin kuva ja sitten hiiren oikean napin valikosta Change picture ja uusi kuva tiedostolistauksesta. Tällöin kuvan koko ja muut asetukset säilyvät. Kuvaviitettä varten valitse References > Cross-reference > Insert reference to: Paragraph number. 
Kuvatekstin tyyppi on tässä Figure Caption, joka tekee juoksevan numeroinnin automaattisesti. Vaihtoehtoinen tapa on valita kuva ja hiiren oikealla napilla Insert Caption. Tällä tavoin kuvan numeroinnin saa halutessaan muotoon 1.1, jossa ensimmäinen numero on luvun numero.
[bookmark: _Toc118865070][bookmark: _Toc119224917][bookmark: _Toc363738142][bookmark: _Toc535531170]Taulukot
Kuvien tapaan taulukot numeroidaan ja varustetaan otsikolla, kuten  Taulukko 1. Taulukkoteksti sijoitetaan samalle sivulle taulukon kanssa ja taulukon yläpuolelle. Suureet, lyhenteet ja symbolit selitetään tarvittaessa tekstissä. Kaikkiin taulukoihin on viitattava tekstissä, mieluummin ennen taulukkoa. Taulukon keskeinen sanoma ja tulkintaohjeet selitetään tekstissä. 
Taulukon otsikkotyyppi on tässä Table Caption, jossa on numeroinnin lisäksi asetukset Keep with Next ja Keep lines together. Taulukko lisätään valitsemalla Insert > Table. Taulukon ominaisuuksista kannattaa varmistaa, ettei Allow row to break across pages ole valittuna. Valitse Alignment:Center ja Text wrapping:Around. Sen jälkeen taulukon saa nätisti sivun ylälaitaan painamalla Positioning ja valitsemalla sieltä Vertical Position 0 cm Relative to Margin. Lisäksi voi samalla määritellä Distance to surrounding text: Bottom 0.5 cm, jolloin tekstin ja taulukon väliin siisti tila ilman rumia rivinvaihtoja. Viite lisätään References > Cross-reference > Insert reference to: Paragraph number. Otsikkoriville on tässä 2 tekstityyppiä Table header (left) ja (right) tasauksen mukaan. Taulukon soluille on vastaavasti 2 tyyppiä Table cell (text) ja (number).


	Aine
	Paksuus (nm)
	Korjaus- kerroin
	Paine 
(mbar)
	Lämpötila
(°C)
	Virta
(mA)
	Nopeus (nm/s)

	SiO2
	181,0
	1,10
	3,0∙10-5
	90,6
	20−23
	0,2

	TiO2
	122,1
	1,55
	15,0∙10-5
	91,1
	93−100
	0,1


[bookmark: _Ref20470436] Esimerkki höyrystysolosuhteista kahdessa ohutkalvorakenteessa.
Taulukon sarakkeet otsikoidaan ja suureet sekä yksiköt laitetaan näkyviin. Otsikkorivi kannattaa erottaa muusta taulukosta esimerkiksi lihavoinnilla ja tuplaviivalla. Taulukon järjestyksellä on suuri merkitys. Jokaista solua ei pidä ympäröidä reunaviivalla, koska taulukosta tulee raskaslukuinen. Lisää vaakaviiva taulukon ylä- ja alareunaan. Vaakaviivoja voi käyttää esimerkiksi 4–5 rivin välein, ellei tietoja muuten ole jaettu kategorioihin tai selkeys sitä vaadi. Sarakkeen numeroarvot tasataan oikealle (optimitilanteessa desimaalipilkun kohdalta), jolloin arvoja on helppo vertailla. Arvoja kannattaa lisäksi sisentää, jotta ne eivät ole kiinni solun oikeanpuoleisessa reunaviivassa. Tavoitteena on, että suureet ilmaistaan SI-yksikössä ja käytetään joko vakiintuneita etuliitteitä tai kymmenen potenssin muotoja siten, että ne voidaan laittaa otsikkoriville. Muutamia suosituksia taulukoiden ja kuvien käytöstä löydät lähteestä [5].
[bookmark: _Toc118865071][bookmark: _Toc119224919][bookmark: _Toc121032630][bookmark: _Toc363738144][bookmark: _Toc535531171][bookmark: _Toc118865072][bookmark: _Toc119224926]Matemaattiset merkinnät 
[bookmark: _Toc119224921][bookmark: _Toc121032632]Käytä selvyyssyistä yleensä numeroita kuin kirjaimia lukuarvoissa, esimerkiksi”6 työvaihetta” on selkeämpi ja parempi kuin ”kuusi työvaihetta”. Tuhaterottimen käyttö selkeyttää tekstiä. Desimaalipilkkua edeltävä nolla tulee aina merkitä. Suomen kielessä käytetään virallisesti desimaalipilkkua, englannin kielessä desimaalipistettä.
Numeroiden tavoin myös mittayksiköt kannattaa kirjoittaa lyhenteinä. Mittayksikön ja numeroarvon välissä on välilyönti, mutta niiden tulisi olla samalla rivillä[footnoteRef:1]. Taulukko tai kaavio on parempi esitystapa, jos tekstin sekaan tulee runsaasti numeroarvoja. Usein numeroarvoihin voi liittää laadullisen määreen, ja vastaavasti kaikkiin laadullisiin määreisiin (suuri, pieni, kallis, nopea) tulisi liittää numeroarvo kuvaamaan suuruusluokkaa. Numeroiden kanssa ei tarvitse käyttää sijapäätettä, jos seuraava sana on samassa sijassa (taivutusmuodossa), esimerkiksi ”jakautuu 10 osaan” ja ”20 ja 50 sentin kolikot”. On myös tapauksia, joissa sijapääte pitää merkitä, esimerkiksi ”osallistujia 7:stä eri maasta”.  [1:  LaTeXissa tämän saa aikaan käyttämällä merkkiä ”~” välilyönnin tilalla, Wordissä symbolia (erikoismerkkiä) non-breaking space.] 

Tekstissä tulee ensisijaisesti käyttää yleisesti tunnettuja ja hyvin määriteltyjä käsitteitä, joiden kirjoittamiseen on yleensä jokin vakiintunut merkintätapa tai symboli. Uudet käsitteet ja merkinnät pitää määritellä, kun ne esiintyvät tekstissä ensimmäisen kerran. Symboleissa ja mittayksiköissä isot ja pienet kirjaimet tarkoittavat eri asioita. Samaa symbolia ei tule käyttää monessa eri merkityksessä. Mittayksiköt merkitään selvästi. 
Matemaattiset merkit ja kreikkalaiset kirjaimet löytyvät LaTeXin makroista ja kaavamoodeista, kuten $\Theta(n^2)$ tai \begin{equation} \sin(\frac{\pi}{2}) = 1 \end{equation}. MS Wordissa ne löytyvät valikon Insert > Symbol (tai Equation) kautta. Yksinkertaiset kaavat voivat olla osa virkettä (siis tekstiä) ja ilman numeroa Esimerkkinä toisesta tavasta Newtonin 2. peruslaki voidaan ilmaista muodossa
	  										      (1)
jossa m on kappaleen massa, a on kiihtyvyys ja F on voima. Huomaa, että symbolien merkitys selitetään heti kaavan yhteydessä.
Matemaattinen kaava numeroidaan, jos se on omalla rivillään ja siihen viitataan muualla tekstissä, katso esimerkiksi kaava (1). Usein numero on tavallisten sulkujen sisällä ja tasattu oikeaan laitaan, kuten tässä ohjeessa. Kaavassa (1) on käytetty englantilaisen kulttuuripiirin tapaa käyttää välimerkkejä myös kaavoissa, tässä lopun pilkkua. Suomenkielisessä tekstissä voi välimerkit jättää pois omalla rivillään olevista kaavoista. Toisinaan matemaattisen rakenteen edessä on tunniste, kuten Määritelmä 1 tai Lause 1 [4]. Numerointi voi olla juokseva läpi koko tekstin tai aina yhden luvun sisällä, siis joko (1), (2)… tai (1.1), (1.2),…, (2.1).
Älä aloita uutta virkettä matemaattisella symbolilla. Yleensä teknisfysikaalisessa tekstissä kursivoidaan muuttujat, kuten x ja y. Kursivoinneissa kannattaa ainakin aluksi luottaa kaavaeditorin automatiikkaan, esimerkiksi LaTeX [3] on siinä erinomainen. Sen sijaan alkeisfunktioita, erikoisfunktioita ja operaattoreita merkitään tavallisella kirjasimella:
	sin(2x+y), 	grad T, 	div B, 	lim (x2 – 1)/(x + 1).
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	void jarjesta( Kirjainpari taulukko[], int koko )
{
  // Järjestetään taulukko siten, että jokaisella kierroksella
  // valitaan alkio, joka kuuluu taulukon ensimmäiseksi ja siirretään
  // se oikealle paikalleen.
  for( int i = 0; i < koko; ++i )
  {
    // Etsitään pienin eli lähinnä aakkosten alkua oleva
    // kirjan lopputaulukosta
    int pienimmanKohta = i;
    for( int j = i; j < koko; ++j )
    {
      if( taulukko[ j ].korvattava
          < taulukko[ pienimmanKohta ].korvattava )
      {
        pienimmanKohta = j;
      }
    }
    // Vaihdetaan pienin alkio omalle paikalleen
    Kirjainpari tmp            = taulukko[ i ];
    taulukko[ i ]              = taulukko[ pienimmanKohta ];
    taulukko[ pienimmanKohta ] = tmp;
  }
  return;
}


	[bookmark: _Ref391563616]Esimerkki ohjelmakoodin esittämisestä kuvan tapaan.


[bookmark: _Toc363738148][bookmark: _Toc535531172]Ohjelmat ja algoritmit
Koodin kirjasinlajina käytetään tasalevyistä kirjasinlajia (jonka merkit ovat siis yhtä leveitä) kuten Courier New, Consolas tai näiden muunnoksia. 
Kun ohjelmakoodin tai algoritmin pituus on alle 10 riviä eikä siihen enää myöhemmin tekstissä viitata, se voidaan esittää kuten kaavat. Pidemmät, alle sivun mittainen ohjelmakoodi tai algoritmi kuvan tapaan, kuten Ohjelma 1, otsikkona ”Ohjelma” tai ”Algoritmi”. Tässä koodi on laitettu yksirivisen taulukon sisään ja lisäksi on estetty taulukkorivin jakaminen eri sivuille. Tekstityylejä on tässä pohjassa valmiina Code, Code row number ja Code Caption. Ensin mainittua kannattaa korostaa lihavoimalla varatut sanat.
Koodiin on hyvä lisätä muutamia kommentteja ja sisentää se johdonmukaisesti. Koodin toiminta selitetään aina myös juoksevassa tekstissä pääpiirteissään, lähinnä siitä esitetään muutamia avainhuomioita. Esimerkiksi LaTeX-ohjelman paketti listings [2][3]osaa kätevästi sisällyttää sekä oikeita kooditiedostoja että pseudokoodia tekstiin, lisätä automaattisesti rivinumeroinnin ja korostaa monet varatut sanat.
[bookmark: _Toc535531173]Viittaustekniikat
Viittaus sisältää kaksi pääkohtaa: 1) tekstissä esiintyvän lähdeviitteen ja 2) lähdeluettelon, jossa on jokaisen lähteen yksilöivät (bibliografiset) tiedot. Tässä osiossa esitellään 2 yleistä viittausten merkintätapaa: 
numeroviittausjärjestelmä (Vancouver-järjestelmä), esim. [1], [2]…
nimi-vuosijärjestelmä (Harvard-järjestelmä), esim. (Weber 2001), (Kaunisto 2003)…
[bookmark: _Toc363738158]Numeroviittaus sijoitetaan hakasulkeisiin ja nimi-vuosiviittaus kaarisulkeisiin. Ensin mainitussa käytetään juoksevaa numerointia ja jälkimmäisessä tekijän sukunimeä ja julkaisuvuotta. Kumpikin viittaustapa on sallittu, ja niiden yleisyys vaihtelee aloittain. Valitse yksi ja ole järjestelmällinen sitä käyttäessäsi.
[bookmark: _Toc535531174]Lähdeviittaukset tekstissä
Lähdeviittaus sijoitetaan tekstin joukkoon mahdollisimman lähelle viittauskohtaa. Pääsääntönä tekstiviittaus sijoitetaan virkkeen sisälle ennen pistettä. 
[bookmark: _Toc363738160]Weber väittää, että … [1]. 
Cattaneo et al. esittävät tutkimuksessaan [2] uuden…
Tuloksena on … [1, s. 23]. Pitää myös huomata… [1, s. 3336]

Esitetyn teorian mukaan … (Weber 2001).
Erityisesti on huomioitava… (Cattaneo et al.).
Weber (2001, s. 230) on todennut …

Alan kirjallisuudessa [1,3,5] esitetyn mukaan…
Alan kirjallisuudessa [1][3][5] esitetyn mukaan…
Aihetta on tutkittu ja raportoitu erittäin laajasti [6–18]…

…kirjallisuudessa (Weber 2001; Kaunisto 2003; Cattaneo et al. 2004) on  esitetty …

MS Wordissa valitse References > Cross-reference > Insert reference to: Paragraph number, kun luot tekstiin viitteitä lähdeluetteloon, kuviin tai taulukoihin. Tekstiä muokatessa numerointi voi muuttua. Voit päivittää numerot valitsemassa koko tekstin (CTRL+a tai Select > Select All), sitten hiiren oikean napin valikosta Update Field ja lopuksi Update entire Table. Jos viite menee rikki – esim. kohde poistetaan – tekstissä näkyy lihavoituna ilmoitus ”Error! Reference source not found”. Tarkista ettei niitä jää tekstiisi. MS Wordin ristiviittaus saattaa helposti rikkoutua muutenkin. Se saattaa jäädä osoittamaaan väärään lähteeseen, esimerkiksi [12] eikä [13]. 
[bookmark: _Toc363738161][bookmark: _Toc535531175]Lähdeluettelo
Lähteestä kerrotaan vähintään taulukon 2 mukaiset tiedot mainitussa järjestyksessä pilkuin eroteltuina, jos ne tiedetään. 
Taulukko 2	Julkaisujen tärkeimmät bibliografiset tiedot.
	#
	Numeroviittaus
	#
	Nimi-vuosiviittaus

	1.
	tekijät,
	1.
	tekijät,

	
	
	2.
	(julkaisuaika suluissa)

	2.
	otsikko,
	3.
	otsikko,

	3.
	julkaisija,
	4.
	julkaisija,

	4.
	julkaisuaika,
	
	

	5.
	sivut,
	5.
	sivut,

	6.
	verkko-osoite, jos on
	6.
	verkko-osoite, jos on



Tässä on esimerkkinä viittaus lehtiartikkeliin molemmilla tavoilla.
[100]	K. Keutzer, A.R. Newton, J.M. Rabaey, A. Sangiovanni-Vincentelli, System-level design: orthogonalization of concerns and platform-based design, IEEE Transactions on Computer-Aided Design of Integrated Circuits and Systems, vol.19, no.12, Dec 2000, s.1523‒1543.

Keutzer, K., Newton, A.R., Rabaey, J.M. & Sangiovanni-Vincentelli A. (2000). System-level design: orthogonalization of concerns and platform-based design. IEEE Transactions on Computer-Aided Design of Integrated Circuits and Systems. Vol.19(12), s.1523‒1543.

Opinnäytteissä lähdeluettelo kannattaa järjestää aakkosjärjestykseen ensimmäisen kirjoittajan sukunimen perusteella. Tässä pohjassa lähdeluetteloa varten on tekstityyli BibItem.
[bookmark: _Toc535531176]Yhteenveto
Ohjeilla pyritään mahdollisimman selkeään ja täsmälliseen tekstiin, joka on tärkeää kaikissa kirjallisissa raporteissa. Tämän dokumenttipohjan ja vastaavan LaTeX-pohjan avulla töillä on yhtenäinen ja selkeä ulkoasu.
Jokaisella kirjoituksella ja esityksellä pitää olla yhteenveto. Tätä asiaa korostetaan lisäämällä sellainen tähänkin pohjaan, vaikkakin lyhyenä ja hieman keinotekoisesti. Tiivis yhteenvetotaulukko auttaa kertaamaan tärkeimmät kohdat.
[bookmark: _Toc535531177]Lähteet
[bookmark: _Ref381024245][bookmark: _Ref391557919]Tampereen yliopiston tekniikan alan opinnäytteiden kirjoitusohje. Tampereen yliopisto, Tampere, 2018. Saatavissa: POP > Opiskelu > Diplomityö > Diplomityöohje
[bookmark: _Ref390945803]C. Heinz, B. Moses, J. Hoffmann, Listings – Typeset source code listings using LaTeX, Comprehensive TeX Archive Network (CTAN), 2006. Saatavissa: http://www.ctan.org/pkg/listings
[bookmark: _Ref381026514][bookmark: _Ref381025873][bookmark: _Ref381025428]T. Oetiker, H. Partl, I. Hyna, E. Schlegl, The Not So Short Introduction to LATEX2ε – Or LATEX2ε in 157 minutes, Version 5.01, 2011, 171 p. Saatavissa: http://www.ctan.org/tex-archive/info/lshort/english/
[bookmark: _Ref391637701]K. Ruohonen, Matemaattisen tekstin kirjoittaminen, Tampereen teknillinen yli-opisto, 2009, 7 s. Saatavissa: http://math.tut.fi/~ruohonen/D-tyo-ohje.pdf
[bookmark: _Ref391637583]E. Salminen, Practical advice for writing publications, course material, TKT-9617 Scientific Publishing, Tampere University of technology, Nov 2009 (updated Aug 2012), 97 p. Saatavissa: http://www.cs.tut.fi/~ege/Misc/salminen_figures_styles_v14.pdf


[bookmark: _Toc535531178]Liite A: MS Wordin tekstityylien käyttö
Tyylien määrä pitää pyrkiä minimoimaan, jotta niitä on helppo käyttää ja muokata. Valitettavan monet kirjoittajat käyttävät Wordin tekstityylejä epäjohdonmukaisesti. Yleisesti ottaen tekstiä ei kuulu asemoida lisäämällä rivin- tai sivunvaihtoja, vaan nämä asiat tulee säätää tyyliasetuksista. Samoin kuvien, taulukoiden tai viitteiden numeroiminen käsin johtaa ongelmiin. Yleinen ongelmien lähde on tekstin kopioiminen muista dokumenteista. Usein teksti kannattaa tuoda ilman muotoiluja Paste > Paste special > Unformatted text, sillä muuten tyylien määrä räjähtää. Tekstin ulkoasun muokkaaminen näennäisen kätevästi Wordin yläreunan nappuloilla johtaa usein samankaltaisiin ongelmiin. Dokumentin sisällä tekstiä kopioidessa tai siirtäessä muotoilun voi toki säilyttää.
Avaamalla Apply Styles, näet käytetyt ja mahdolliset tekstityylit, missä niitä on käytetty ja voit muokata niitä tai luoda uusia. Valitsemalla vielä alareunasta Options… voit valita näytetäänkö todella käytetyt vai tässä dokumentissa mahdolliset. Lisäksi voi koiruuttaan valita kaikki Wordin tarjoamat, mutta tiettävästi kukaan ei ole vielä tarvinnut esimerkiksi 9. tason otsikoita. Lisäksi voit valita näytetäänkö pelkät kappaleasetukset (esim. Normal, BibItem…), fonttimuotoilut (Normal + Italic) ja listamuotoilut.
Toisinaan tekstin sekaan jää roikkumaan esimerkiksi lihavoituja kuvia, kursivoituja 10 pisteen rivinvaihtoja tai peräti punainen rivinvaihto jne. Jokaisesta listatusta tyylistä voi onneksi valita Select all X instances, jolloin näkee missä sitä on käytetty. Näin on helppo päästä eroon kummallisuuksista.. Esimerkiksi TTY:n opinnäyteohjeessa oli versiossa 11.3 (Kuva 2a) yli 130 tyyliä, mm. liki identtiset Body text, Body text+Not italic, Normal, Plain text, After:6pt, After:6pt,Line spacing:Single, Before:1pt, Before:1pt,After:0pt, Before:3pt ja niin edelleen. Tyylien määrä puolittui, kun nuo korvattiin yhdellä tyylillä Normal  ja muitakin turhia poistettiin (Kuva 2b).
Lisäksi voit valita muotoilumerkit näkyviin (engl. Show paragraph marks and other hidden formatting symbols) painamalla täytetyn P-kirjaimen peilikuvan näköistä ikonia yläpalkissa. Pedantit ihmiset voivat sitten poistaa tuplavälilyönnit, ylimääräiset rivinvaihdot, rivinvaihtoa edeltävät välilyönnit, ylimääräiset tabulaattorit ja muut roskat. Tarkista myös tekstin kopioinnista huolimatta kaikki lainausmerkit ovat samanlaiset, mielellään “…” eikä "…".

	[image: ]

	a) Versio 11.3. Kiinnitä erityishuomio lukuisiin Arial-pohjaisiin tyyleihin, numeroituihin ja muihin listoihin sekä vasemmalle tasattuihin teksteihin.

	[image: ]

	b) Versio 11.5. Edelleen otsikkotasot 4-9 ovat tarpeettomia, mutta valitettavan vaikeita poistaa.
[bookmark: _Ref394652862][bookmark: _Toc532040188]Tyylit kirjoitusohjeen versioissa 11.3 ja 11.5


Jos dokumentin tulostaminen pdf-tiedostoon heikentää kuvien laatua, valitse asetus High Quality Printing  eikä Standard, tai käytä File > Save as Adobe PDF. 
Muotoiluasetukset ovat muuttuneet Wordin versiossa 2013, mikä saattaa aiheuttaa ongelmia otsikoita ympäröivän tyhjän tilan kanssa ellei käytössä ole Compatibility mode, katso esimerkiksi https://answers.microsoft.com/en-us/office/forum/office_2013_release-word/where-can-i-find-suppress-extra-line-spacing-at/70bf7ca3-a884-40c4-ab59-34d2a04a1a8f
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